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Computer - 1
Chapter-1  Computer : A Useful Machine
Pg-7
Fun Activity
Bicycle, Washing machine, Refrigerator, Calculator
Exercise
A. Choose the correct option.
l.a2.b3.c4.c
B. Tick (v/) the machines run by electricity and cross (X) which are not run by
electricity.
Do yourself.
C. Join the dots and colour the computer.
Do yourself.
D. Match the following columns.
1.b2.d3.a4.¢5.¢
Research Project
Do yourself.

Chapter-2  Uses of Computer

Pg-12

Fun Activity

1LVvV2.vV3X4.X5 v

Exercise

A. Choose the correct option.
l.a2.c3.c4.a

B. Fill in the blanks using the words given below.
1. schools 2. cartoons 3. letters 4. listen 5. solve

C. Write the five things you do on a computer.

1. We can watch movie on computer. 2. We can send and receive messages by
computer. 3. We can type letters on computer. 4. We can listen music, songs on
computer. 5. We can solve sums on computer.

D. Write the name of places where computers are used.
School, Bank, Hospital, Home

Research Project

Do yourself.

Chapter-3  Parts Of A Computer
Pg-18

Fun Activity

CPU, MONITOR, MOUSE, KEYBOARD

Digital World 1 to 5 3



Exercise

A. Choose the correct option.
l.a2.a3.b4.a

B. Match the parts of a computer with its name.
Do yourself.

C. Fill in the blanks using the words given below.
1. Central Processing Unit 2. monitor 3. numbers 4. Wireless mouse 5. pointer

D. Write T for True and F for False.
1.F2.T3.T4.T5.F

E. Who amI?
1. CPU 2. Monitor 3. Mouse 4. Keyboard 5. Wire

Research Project

Do yourself.

Chapter-4  Operating Computer

Pg-25

Fun Activity

Do yourself.

Pg-27

Fun Activity

Do yourself.

Exercise

A. Label the following window.
Do yourself.

B. Choose the correct option.
l.a2.a3.c4.b

C. Complete the following steps and arrange them.

Steps for starting a computer Steps for shutting down a computer
Step 4 Step 2

Switch ON the Montior. Switch OFF the UPS.
Step 3 Step 4

Switch ON the CPU. Switch off the Main Power Supply.
Step 1 Step 1

Switch ON the Power Supply. Click on Start button.
Step 2 Step 3

Switch ON the UPS. Switch off the Monitor.

D. Write T for True and F for False.
1.T2.F3.T4.F5.T

4 Digital World 1 to 5



E. Write some points you follow in your school computer-lab.
1. Enter and exit quietly. 2. No running in the lab. 3. No food or drink in the lab.
4. Print only with permission. 5. Organize before leaving your area.

Research Project

Do yourself.

Chapter-5  Mouse
Fun Activity
Pg-32
Do yourself.
Fun Activity
Pg-34
Do yourself.
Exercise
A. Choose the correct option.
l.c2.b3.c4.a
B. Write T for True and F for False.
1.F2.F3.F4.F5.T
C. Label the mouse buttons.
Do yourself.
D. Fill in the blanks using the words given below.
1. arrow 2. clicking, dragging, scrolling 3. gently 4. scroll wheel 5. mouse pad
E. Identify the actions used for the following.
1. Scroll 2. Double click 3. Select 4. Pointer 5. Drag and Drop
Research Project
Do yourself.

Chapter-6  Keyboard
Fun Activity
Pg-39
Do yourself.
Exercise
A. Choose the correct option.
1.b2.b3.b4.c
B. Fill in the blanks using the words given below.
1. keys 2. alphabetic 3. number 4. Enter 5. Backspace

C. Read the following paragraph. Draw a line where you think the space should
be used and draw where you think sentence is finished to start for a new line.
One is done for you.

1.l am a boy.

Digital World 1 to 5 5



My name is Rohan.

I am six years old.
2. This is a tree.

There are some fruits on it.

The monkey is eating them.
D. Label the keys.
See the picture in the book on Page No 42.

Research Project

Do yourself.

Chapter-7  MS-Paint

Exercise

A. Choose the correct option.
1.c2.b3.c

B. Arrange the following steps in proper order for opening the Paint Window.
Do yourself.

C. Fill in the blanks with the help of the words given below.

1. Drawing area 2. Fill with colour tool 3. MS-Paint 4. Shapes tools
Research Project
Do yourself.

Model Test Paper - 1
A. Can you name these computer parts?
Monitor, CPU, Headphone, Mouse, Keyboard, Speakers
B. Name the places where computer is being used.
School, Hospital, Office, Shops, Bank, Home
C. Complete the following lines.

1. automatic machine. 2. electricity to run. 3. result very fast. 4. easier and saves
time. 5. gets tired

D. Write the steps to Switch ON and OFF the computer.
Switch ON
Step 1 : Switch ON main power supply button.
Step 2 : Switch ON the UPS button.
Step 3 : Switch ON the CPU button.
Step 4 : Switch ON the monitor button.
Switch OFF
Step 1 : Click on the Start button.
Step 2: Click on shut down option.
Step 3 : Switch OFF the Monitor.
Step 4 : Switch OFF the UPS button. Switch OFF the main power supply button.

6 Digital World 1 to 5



Model Test Paper -2
A. Label the mouse buttons.

B.

E.

Do yourself.

Colour the keys according to the codes given below.

Do yourself.

Label the paint window.

See the picture in the book on Page No 42.

Name the following tools.

Pencil tool, Brushes, Fill with colour tool, Shapes group, Eraser tool
Choose the correct option.

1.c2.b3.b4.c

National Cyber Olympiad

Logical Reasoning

1.d2.c3.c

Computer And Information Technology
4.25.06.¢7.¢8.09.d10.b11.c12.b 13.d
Achievers Section

14.a15.b

Digital World 1 to 5



Computer - 2
Chapter-1  Computer At Different Places
Fun Activity
Pg-6
For what else are computers used in your school?
1. Drawing 2. For educational movie 3. For download subject matter
Exercise
A. Choose the correct option.
1.2a2.b3.b4.b
B. Fill in the blanks with the help of words given below.
1. Computer 2. diseases 3. schools 4. satellites, rockets 5. ATM
C. Read the hints and guess the places where computers are being used.
1. Hospital 2. At home 3. Police station 4. Airport
D. Answer the following questions.

1. (i) Computers are used for diagnosing diseases. (ii) Computers help in keeping
records of patients. 2. (i) Computer is used for preparing results timetable etc.
(ii) Computer is used for making subjects notes. 3. (i) Computer is used for
booking or canceling tickets. (ii) Computers give arrival and departure timing of
trains and airplanes. 4. Yes, life will be little difficult without computers because
computers help us in many ways and saves our time.

Research Project
Do yourself.

Chapter-2  Working of Computer

Fun Activity

Pg-11

Complete the flow charts.

Devices : Keyboard CPU  Monitor

Steps : Input  Processing ~ Output

Exercise

A. Choose the correct option.
l.a2.a3.c4.c

B. Fill in the blanks with the help of words given below.
1. Input 2. cabinet 3. CPU 4. Scanner 5. Output, processing

C. Answer the following questions.

1. A computer is an electronic machine, which cannot work on its own. 2. Input
Processing ~ Output 3. CPU 4. a. Scanner b. Mouse 5. Monitor

D. Tick (v) if the following outputs are correct. Put (X) if they are wrong.
1.V2.X3.X4.V 5.V
Research Project

Do yourself.
8 Digital World 1 to 5



Chapter-3  Input Devices And CPU

Fun Activity
Pg-18
Tablet pen, Light pen, Camera
Exercise
A. Name the given input devices.
Mouse, Scanner, Microphone, Web camera, Joy stick, Pen tablet, Keyboard
B. Choose the correct option.
1l.a2.b3.c4.b
C. Fill in the blanks with the help of words given below.
1. Web camera 2. Backspace 3. memory 4. Alphabet 5. Printer
D. Answer the following questions.

1. The devices that are used to enter data or give instruction to the computer are
called input devices. 2. a. Keyboard : Keyboard is used to enter data in
computer. We can use different keys to type data. There are many keys on the
keyboard. b. Mouse : Mouse is used to point at things on the monitor. It is used to
select and open things displayed on the screen. c. Printer : A printer print out
information from the computer on paper. The printed copy on paper is called the
hard copy. 3. CPU is the most important part of computer as it does all processing
work. It does calculation store the data. That is why it is called Brain of the
computer.

Research Project

Do yourself.

Chapter-4  Output And Storage Devices

Fun Activity

Pg-23

Do yourself.

Exercise

A. Choose the correct option.
1.b2.a3.b

B. Write (S) for Storage device and (O) for Output device.
Do yourself.

C. Fill in the blanks with the help of words given below.
1. printer 2. Compact Disc 3. Dot matrix 4. LCD, CRT

D. Answer the following questions.

1. The devices, that show output or information are called output devices.
2. a. Monitor : A monitor is similar to a Television. It shows information and
other things. What ever we type through keyboard. It displayed on the
screen/monitor. b. Printer : A printer prints out information from the computer
on paper. There are different types of printers which print either in black and

Digital World 1 to 5 9



white or in colour. c. Pen Drive : Pen Drive is a type of storage device. It can store a
lot of more information than a CD. It is also known as USB drive. d. Hard Disk :
The Hard disk is the main storage device of the computer. All the software and data
in a computer. All the software and data in a computer is stored on the hard disk. 3.
CD : CD stands for Compact Disk. It is a shiny circular surface that store lot of
information. DVD : DVD stands for Digital Versatile Disk. It looks similar to CD
but it can store more information than a CD.

Research Project

Do yourself.

Chapter-5  Introduction To MS Windows

Fun Activity

Pg-29

1. Unix 2. Linux

Exercise

A. Choose the correct option.
l.a2.c3.c4.b

B. Label the following components of windows 7.
See picture in the book on Page No 31.

C. Answer the following questions.
1. An operating system is a program that helps us to communicate with the
computer. 2. Window is a GUI operating system which makes the use of computer
and easy task for people. 3. The windows 7 desktop has four components :
(a) Icons : These are small pictures present on the desktop. They represent different
programs, applications or folders, etc. (b) Taskbar : The long bar seen at the bottom
of desktop is called taskbar. It contains the Start button and clock. (¢) Start button :
This button is used to open any program, game or software on the computer.
(d) Desktop Background : This is the coloured area seen behind the icons we can
change the background the way we want. Gadgets : Gadgets are mini programs that
provide information at a glance and also provide access to frequently used tools.
4. All program menu shows the list of programs and software.

D. Fill in the blanks with the help of word given below.

1. Operating System 2. icons 3. desktop 4. Start

Research Project

Do yourself.

Chapter-6  More In MS-Paint
Fun Activity

Pg-35

Do yourself.

10

Digital World 1 to 5



Pg-42
Write all the tools used to make the following drawing.
1. Line tool 2. Ellipse tool 3. Rectangle tool 4. Pencil tool 5. Eraser tool
Exercise
A. Choose the correct option.
l.a2.b3.c4.cS.a
B. Fill in the blanks with the help of words given below.
1. line 2. ellipse 3. undo 4. drawing 5. foreground, background
C. Answer the following questions.

1. (a) Title bar : Title bar shows the names of the program. Minimize, Maximize,
Restore and Close button in pain window. (b) Ribbon : Ribbon contains the
different tabs, tools, colours and command buttons to work in paint. 2. The curve
tool is used to draw curved line. 3. Undo : Undo command is used to cancel last
drawing action in paint. Redo : Redo command is used to repeat last drawing
action in Paint. 4. Follow the given steps : (i) Click on Save button. (ii) Save as
dialog box appears. (iii) Type a name for the file in the File name box on the new
save as window. (iv) Click on Save button. 5. If we try to colour a shape that is not
closed the colour will leak out. To correct it, follow these steps : (i) Press Ctrl + Z
to reverse the action. (ii) Select the Brush tool and Foreground color. (iii) Go to
the part that is not closed and close it.

D. Match the following columns.
Do yourself.
E. Solve the crossword puzzle with the help of the picture clues.
1. ELLIPSE 2. PENCIL 3. ERASER 4. LINE 5. AIRBRUSH 6. CURVE
Research Project
Do yourself.

Chapter-7  Wordpad
Fun Activity
Pg-50
Do yourself.
Fun Activity
Pg-53
Font name, Font size, Bold, Italic, Underline
Exercise
A. Choose the correct option.
1.a2.b3.c 4.¢5.b
B. Fill in the blanks with the help of words given below.
1. Wordpad 2. Work area 3. Cursor 4. Editing 5. Underline
C. Label the components of the Wordpad window.
See picture in the book on Page No 57.
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Answer the following questions.

1. Wordpad is an application program used to write text on a computer.
2. a. Selecting text : To select the text, press the mouse button, drag the mouse
button towards the end point of the text and release the button at the end point.
b. Editing the text : Editing means making corrections or changes in the text.
The term editing includes deleting, copying moving and replacing of text. 3. To
change font style and size follow these steps to change font : Step 1 : Select the
text. Step 2 : Click on the home tab. Step 3 : Select a bigger font size and a font of
your choice . The selected text well become bigger in size and style will also
changed. 4. Step 1 : Click the Quick Access toolbar option. Step 2 : Select the
open option. Step 3 : The open dialog box gets displayed. Step 4 : Select on the
open button. Step 5 : Click on the open button. The file will open.

Research Project

Do yourself.

Model Test Paper - 1

A.

Fill in the blanks.

1. school 2. salary 3. output 4. CRT, LCD 5. calculation 6. hard 7. storage 8. Web
camera 9. voice 10. mathematical

Name the following devices and write (I) for Input, (O) for Output, (P) for
Processing and (S) for Storage devices.

Do yourself.

Answer the following questions.

1. A computer is an electronic machine, which cannot work on its own. 2. The
devices that are used to enter or give instruction to the computer are called input
devices. 3. Monitor, keyboard, CPU, UPS, mouse are the main parts of the
computer. 4. a. Printer : A printer prints out information from the computer on
paper. The printed copy on paper is called the hard copy. b. Hard Disk : The
Hard disk is the main storage device of the computer. All the software and data in
a computer is stored in the hard disk. ¢. Keyboard : Keyboard is used to enter
data in computer. We can use different keys to type data. There are many keys on
the keyboard. d. Mouse : Mouse is used to point at things on the monitor. It is
used to select and open things displayed on the screen. 5. CD : CD stands for
Compact Disc. It is a shiny circular surface that store lot of information. DVD :
DVD stands for Digital Versatile Disc. It looks similar to CD but it can store more
information than a CD.

Read the hints and guess the places where computers are being used.

1. In Hospital 2. At Home 3. At Police Station 4. At Airport

Model Test Paper - 2

A.

12

Fill in the blanks.

1. Operating System 2. Desktop 3. working area 4. Editing 5. Line 6. Undo
7. Icons 8. pictures

Digital World 1 to 5



B. Identify the following paint tools.
Line, Curve, Brushes, Text, Eclipse, Eraser, Fill with colour, Pencil

C. Answer the following questions.
1. Windows operating system is a GUI operating system which makes the use of
computer an easy task for people. 2. Word Pad is an application program used to
write text on a computer. 3. Undo : Undo command is used to cancel last drawing
action in paint. Redo : Redo command is used to repeat last drawing action in
paint.

D. Label the components of WordPad window.
See picture in the book on Page No 62.

E. Write the steps for following.

1. Follow the given steps : Step 1 : Click on Save button. Step 2 : Save as dialog
box appears. Step 3 : Type a name for the file in the file name box on the New
Save as window. Step 4 : Click on Save button. 2. To change font style and size
follow these steps to change font : Step 1 : Select the text. Step 2 : Click on the
Home tab. Step 3 : Select a bigger font size and a font of your choice . The
selected text well become bigger in size and style will also changed.

National Cyber Olympiad

Logical Reasoning

1.c2.c3.b

Computers And Information Technology
4.25.¢6.b7.d8.c9.c10.b11.d12.d 13.d
Achievers Section

14.d15.a
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Computer - 3

Chapter-1  Early And Modern Computers

Fun Activity

Pg-7

Write the year and scientist name who have given the following computing

machines.

Year : 1. 1616 2. 1642 3. 1833 4. 1882

Scientist Name : 1. John Napier 2. Blaise Pascal 3. Charles Babbage 4. Charles

Babbage

Fun Activity

Pg-9

Write the full form of the following.

1. Electronic Numerical Integrator And Calculator 2. Electronic Delay Storage

Automatic Calculator 3. Electronic Discrete Variable Automatic Computer

4. International Business Machine

Exercise

A. Choose the correct option.
l.a2.a3.b4.c5.b

B. Fill in the blanks.
1. Charles Babbage 2. Al 3. Difference engine 4. vacuum tubes 5. third

C. Match the following columns.
1.b2.e3.a4.d5.c

D. Write T for True and F for False.
1. True 2. True 3. False 4. True 5. False

E. Answer the following questions.
1. First Generation computers were built using vacuum tubes which looked like
small bulbs and Second Generation computers replaced vacuum tubes by
transistors. They were smaller in size, consumed less electricity. 2. Early-man
used stone, pebbles for counting. 3. IC were used in place of vaccum tubes and
transistors. The use of ICs brought above further reduction in size, increase in
speed of computers and made them very reliable. 4. Artificial Intelligence is a
concept which makes the computer think like human beings. 5. a. Abacus : It was
the first calculating machine. It is wooden frame with rows of wires and beads. It
was developed in China about 5000 years ago. b. Pascaline Calculator : In 1642,
Pascaline was invented by Blaise Pascal. It was able to perform addition and
subtraction upto hundred and thousands. It has a box with eight moveable wheels
called dials. c. Electronic Computers : After the discovery of electricity, better
machines were made, which were more reliable and capable of performing
thousands of calculations per minute. These were called electronic computers.

F. Name the following machines.
Napier’s Bones, Abacus, Personal Computer, ENIAC, Pascaline, Artificial
Intelligence

Chapter-2  Hardware And Software

Fun Activity

Pg-18

14 Digital World 1 to 5



Complete the following table.

State Function Device used

Input Enter data Keyboard, Mouse

Output Shows result Monitor, Printer

Process Process the input data CPU

Storage Help to storing data Pen drive, Hard disc

Fun Activity

Pg-21

LCD Monitor, CRT Monitor, USB (Pendrive), Scanner, Light pen, Dot Matrix Printer
Exercise

A.

B.

Choose the correct option.

1.c2.b3.c4.c5.a

Fill in the blanks.

1. 12 2. pixels 3. system software 4. USB 5. Application

Match the following columns.

1.d2.a3.¢e4.c5.b

Answer the following questions.

1. Computer is an electronic machine which takes data called INPUT and then
processes it and gives us result called OUTPUT. This is known as IPO cycle.
2. Hardware are the physical components of the computer. The hardware devices
are the combination of input devices, output devices, CPU and storage devices.
(a) Input devices : keyboard, mouse, joystick, light pen, scanner, touch screen.
(b) Output devices : Monitor, speakers, printer (¢) Central Processing Unit
(d) Storage devices : Pendrive, hard disk, CD -Rom 3. Processing unit or system
unit or CPU is the most important part of a computer. It helps to process the input
data and commands to give the output. It is also known as ‘The Brain of
Computer’. It has three main components : (a) Control Unit (CU) (b) Arithmetic
Logic Unit (ALU) (¢) Memory Unit (MU) 4. Which devices of computer show
the result of our works are called output devices. Some output devices are
monitor, speakers, printer etc. 5. Software is a set of programs. To perform a
well-defined function to run any hardware. There are two types of software :
(a) Operating or system software (b) Application software

Write T for True and F for False.

1. False 2. False 3. True 4. True 5. True

Circle the odd one out and give reason for your choice.

Do yourself.

Chapter-3  Windows-Operating System
Fun Activity

Digital World 1 to 5 15



Pg-29
Which the help of your teacher, write the uses of given taskbar option.

1. To open programs quickly we can use Quick Launch Bar. 2. It is used to adjust the
sound of song, movie etc. 3. It is used to see date and time.

Exercise

A. Choose the correct option.
1.a2.b3.b4.a

B. Fill in the blanks.
1. Tittle 2. icons 3. Desktop 4. Operating System 5. file

C. Match the following columns.
l.e2.d3.2a4.f5.¢c6.b

D. Answer the following questions.
1. An operating system is a program which helps a user to communicate with the
computer. [0S, Linux are two operating systems. 2. GUI is a Graphical User
Interface which allows users to work with icons, window etc. 3. (a) Desktop :
Desktop is the main display screen of a computer through which other programs
and applications run, desktop also contain, icons, start button, taskbar etc.
(b) Recycle Bin : This is a kind of computer’s dustbin where all deleted or
removed files of computer goes. Deleted file or folder remains in the Recycle bin
till we empty it. 4. Files are the collection of related information. Folder keeps the
other folder or files in it. 5. Taskbar is normally seen at the bottom of the desktop.
It contains Start button and Notification tray. Tittle bar is on the top. It display the
name of the document.

E. Write T for True and F for False.
1. True 2. False 3. True 4. False 5. False

F. Label the parts of windows desktop system.

See picture in the book on Page No 35.

Chapter-4  More On MS Paint

Fun Activity
Pg - 38
Pencil, Brush, line, Eraser, Airbrush, Ellipse
Exercise
A. Choose the correct option.
1.b2.c3.a4.a5.a
B. Fill in the blanks.
1. Rectangle tool 2. image 3. text 4. Font 5. Copy
C. Match the following columns.
See picture in the book on Page No 44.
D. Write T for True and F for False.
1. False 2. False 3. True 4. False 5. True
E. Answer the following questions.
1. Step 1 : Click on Paint button and select open option. Step 2 : Select the file
name that is to be opened or type the file name in the File name box. Step 3 :
16 Digital World 1 to 5



Click on Open button. 2. (i) Pencil tool is used to draw freehand thin lines.
(ii) The Line tool is used to draw straight lines. (iii) The Curve tool is used to
draw curves. (iv) The Eraser tool erases everything you drag over. (v) The
Brush tool is used to draw freehand thick or thin lines as required by selecting the
brush tip. 3. Copy-Paste option is used to move a drawing anywhere on the
drawing area or to make a multiple copies of drawings. 4. < Select the text. >
<Select the Font name in the font group.> 5. To Resize a drawing, <Select the
image wing select tool.> < Select the resize option in the Image group on the
Home tab.> <Specify the resize in ‘Percentage’ or ‘Pixels’ and skew in
degrees for both horizontal and vertical.> < Click on OK button.>

Chapter-S  Microsoft Word 2007
Fun Activity

Pg-50

Complete the steps to open MS Word.

Step 1 : Click on Start button. Step 2 : Click on All programs. Step 3 : Click on
Microsoft office. Step 4 : Click on Microsoft Office Word 2007.

Exercise

A.

B.

Choose the correct option.

l.c2.b3.c4.c

Fill in the blanks.

1. Word Processing 2. Title 3. Tabs, command 4. Formatting 5. Status Bar
Write T for True and F for False.

1. False 2. True 3. False 4. True 5. True

Answer the following questions.

1. Microsoft word is a popular word processing software. We can create, open,
save, print and close document in MS word 2007. 2. Title bar, Status bar,
Document window, Ruler, Ribbon etc. 3. Microsoft Word makes it easy to check
that your document is spelt correctly and uses good grammar. We can either
correct the spelling as. We type, or run the Spelling and Grammar check at any
time while producing our document. 4. To create a new document. <Click on the
Microsoft office button and select New option.> The new document dialog box
appears. <Click on blank document option from the blank and recent section and
click on blank document.> 5. Formatting means changing the appearance of the
test in a document.

Label the components of MS Word window.

See picture in the book on Page No 60.

Chapter-6 MSW LOGO
Fun Activity

Pg-66

Do yourself.

Fun Activity

Pg-69

Do yourself.
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Exercise

A. Choose the correct option.
l.a2.c3.a4.b

B. Fill in the blanks.
1. Language of Graphics Oriented 2. LOGO 3. multiplication 4. HT 5. RT

C. Answer the following questions.
1. LOGO is a programming language which is one of the easiest, oldest and most
user friendly computer language. 2. LOGO is used for drawing figures and
objects, perform calculations and type or print the text. 3. (a) Addition : We use
‘+” sign. (b) Subtraction : We use ‘-’ sign. (¢) Multiplication : We use © ’ sign.
(d) Division : We use ‘/’symbol. 4. LT primitive changes the direction of the
turtle towards its left side and RT primitive changes the direction of the turtle
towards its right side. 5. a. moves turtle in forward direction. b. to close MSW
LOGO c. Turtle disappear from the screen d. To show turtle again

D. Match the column sets of LOGO Primitives with the turtle’s movement.
Do yourself.

E. Write the commands for the following and also their results.
(a) PR 20 + 30 output 50 (b) PR 8 7 output 56 (¢) PR 96/6 output 16

F. Label the MSW LOGO Window.
See picture in the book on Page No 71.

Chapter-7  Introduction to Internet
Fun Activity
Pg-76
Dave Hyatt, 2004 Blake Ross, Teff Nelson 2013, Thomas Reardon 2003, John
Tetzchaner, 1995 , Marc Andrecsser 1994
Fun Activity
Pg-77
Write the full form of the following.
1. World Wide Web 2. Integrated Services Digital Network 3. Kilobytes Per Second
4. Megabytes Per Second 5. Uniform Resource Locator
Exercise
A. Choose the correct option.
1.c2.a3.b4.a5.b
B. Fill in the blanks.
1. Integrated Services Digital Network 2. web pages 3. Web browsers 4. URL
5. E-mail
C. Answer the following questions.

1. Internet is the huge network of millions of computers to connected each other
in all over the world. Uses of Internet : (i) We can buy airline, railway, bus, or
even movie tickets. (i) We can do banking transactions without going to bank.
(iii) We can study online with the help of online courses. 2. A P/C, A modem to
let us connect our computer to a telephone line. A telephone line, A web browser
software, A subscription to NISP. 3. Search engines search the websites

18 Digital World 1 to 5



containing particular information. 4. (a) URL : URLis an Uniform Resource
Locator which is the unique address of a website. This address is made up of parts
separated with dots. (b) Web Browser : A Web browser is a program or software
that allows us to access all the information available on the internet. It display
websites. (¢) E-mail : E-mail is the electronic mail, which is used for sending and
receiving electronic data message at any part of the world.

Write T for True and F for False.

1. True 2. False 3. False 4. False 5. True

Write the full form of the following.

1. World Wide Web 2. International Service Provider 3. Integrated Services
Digital Network 4. Uniform Resource Locator 5. Bharat Sanchar Nigam Limited
Write the name of each web browser or search engine shown below.
Google, Opera Mini, Mozilla, Internet, Website

Model Test Paper - 1

A.

B.

Fill in the blanks.

1. Vacuum tubes 2. USB 3. Title 4. Font 5. Charles Babbage

Choose the correct option.

l.a2.c3.a4.c

Answer the following questions.

1. Integrated Circuit (IC) was used in third generation of computers in place of
vacuum tubes and transistors, while Artificial Intelligence is the technology
which is used in fifth generation of computers. 2. Computer is an electronic
machine which takes data called INPUT and then Processes it and gives us result
called OUTPUT. This is known as IPO cycle. 3. GUI is a Graphical User
Interface which allows users to work with icons, window etc. 4. To resize a
drawing, we follow the given steps : Step 1 : Select the image wing select tool.
Step 2 : Select the resize option in the image group on the home tab. Step 3 :
Specify the resize in ‘Percentage’ or ‘Pixels’ and skew in degrees for both
horizontal and vertical in the respective boxes, according to your requirement.
Step 4 : Click on OK button. 5. a. Desktop is the main display screen of a
computer through which other programs and applications run. b. The Ellipse tool
is used to draw ovals and circles. ¢. To open program quickly we can drag the
program icons on the taskbar. We can follow the steps in the article to restore
Quick Launch Bar. 6. (i) Pencil tool is used to draw freechand thin lines. (ii) The
Line tool is used to draw straight lines. (iii) The Curve tool is used to draw
curves. (iv) The Eraser tool erases everything you drag over. (v) The Brush tool
is used to draw freehand thick or thin lines as required by selecting the brush tip.
7. Copy-paste option is used to move a drawing anywhere on the drawing area or
to make a multiple copies of drawings. 8. Software is a set of programs, to
perform a well-defined function to run any hardware. There are two types of
software : (a) Operating or system software (b) Application software

Write the year and scientist name who have given the following computing
machine.

Year : 1. 1616 2. 1642 3. 1833 4. 1882
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Scientist Name : 1. John Napier 2. Blaise Pascal 3. Charles Babbage 4. Charles
Babbage

Name the following Icons.

Start Button, Clock, MS Word, Folder, Recycle bin, Magnifier, Air Brush Spray,
Brushes

Model Test Paper - 2

A.

B.

Label the components of MS Word window.

Do yourself.

Write the full form of the following.

1. World Wide Web 2. Integrated Services Digital Network 3. Kilobytes Per
Second 4. Megabytes Per Second 5. Uniform Resource Locator

Write the command for the following and also their results.

(a) PR 20 + 30 output 50 (b) PR 8 7 output 56 (¢) PR 96/6 output 16

Fill in the blanks.

1. tabs, commands 2. multiplication 3. Language of Graphic Oriented 4. URL
5. Status bar

Answer the following questions.

1. Microsoft Word 2007 is a popular word processing software. We can create,
open, save, print and close document in MS word 2007. 2. Formatting means
changing the appearance of the test in a document. 3. LOGO is used for drawing
figures and objects, perform calculations and type or print the text. 4. Internet is a
huge network of millions of computers connected all over the world to share
information with each others. Uses of Internet : (i) We can buy airline, railway,
bus, or even movie tickets. (i) We can do banking transactions without going to
bank. (iif) We can study online with the help of online courses. 5. Search engines
search the websites containing particular information therefore. Web browser is
used to open web pages. 6. a. URL : URLis an Uniform Resource Locator which
is the unique address of a website. This address is made up of parts separated with
dots. b. FD : The turtle moves in forward direction. FD is the short form of
Forward. BK : The turtle can move and draw lines backward as well. BK is the
short form of Backward. ¢. LT : Primitive changes the direction of the turtle
towards its left side. RT : Primitive changes the direction of the turtle towards its
right side.

Write the name of each web browser of search engine shown below.
Google, Opera Mini, Mozilla, Internet, Website

National Cyber Olympiad

Logical Reasoning

1.c2.c3.d

Computers And Information Technology
4.b5.¢6.c7.b8.d9.a10.c11.c12.c13. b
Achievers Section

14.a15.a
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Computer - 4

Chapter-1  Hardware And Software
Fun Activity

Pg-8

Identify these devices as Input or Qutput. Write the function of each device.
1. Input 2. Output 3. Output 4. Output

Fun Activity

Match the following columns.

l.c2.¢3.24.b5.d

Exercise

A.

B.

Choose the correct option.

l.a2.b3.c4.a

Fill in the blanks.

1. Data 2. Memory 3. ALU 4. Hardware 5. ROM

Write the full form of the following.

1. Central Processing Unit 2. Arithmetic Logic Unit 3. Digital Versatile Disk
4. Visual Display Unit 5. Random Access Memory

Answer the following questions.

1. Computer is an electronic device that takes raw data as input from the user and
processes it, to give the result (output) and save it for the future use. 2. CPU is
considered as the brain of the computer. CPU performs all types of data
processing operations. It controls the operation of all parts of computer. CPU
itself has following three components : (i) Arithmetic Logic Unit (ALU)
(i) Memory Unit (MU) (iii) Control Unit (CU) 3. Devices which are used to enter
data in the computer and make a link between the user and computer are called
Input Device. Keyboard, mouse, scanners etc. are the input devices. 4. Hardware
are all the mechanical and electronic parts of a computer system which can be
touched. Software are the collection of programs software represented the set of
programs that govern the function of a computer system. 5. ROM : ROM stands
for Read Only Memory. The memory from which we can only read but cannot
write on it. This type of memory is non-volatile RAM : Random Access Memory
is the internal memory of the CPU for storing data. It is volatile memory.
6. a. Language Processor : A language processor is a special type of a computer
software used to converts the instruction into machine computer understand the
machine language i.e., 0 and 1. b. Cache Memory : Cache memory is a very high
speed memory. It is used to hold those parts of data and program which are most
frequently used by CPU. It is faster than main memory. c¢. Secondary Storage :
This type of memory is also known as external memory or non-volatile. It is
slower than main memory. Data is permanently stored even if power is switched
off.

Write T for True and F for False.

1. False 2. False 3. True 4. False 5. True

Chapter-2  Types Of Computers

Fun Activity
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Pg-18

Unscramble the name of type of computer and match them correctly.
TABLET, LAPTOP, PALMTOP, MAINFRAME

Exercise

A.

B.

Choose the correct option.

l.a2.b3.c4.a

Write the value of following.

1. 1024 Gigabytes 2. 1024 Megabytes 3. 1024 Kilobytes 4. 1024 Bytes 5. 8 bits
6. 4 bits

Fill in the blanks.

1. micro-processor 2. miniature 3. Tablets 4. Garbage In Garbage Out 5. super
Answer the following questions.

1. A Personal Computer can be defined as a small in expensive computer
designed for a single user, PC are based on the microprocessor technology that
put an entire CPU on one chip. 2. Mini computers : Mini computers are smaller
in physical size. Mini computer are more powerful than personal computer mini
computers are used for variety of applications. Mainframe computers :
Mainframe computers are very large in size and is an expensive computer.
Mainframe executes many programs parallel and supports many simultaneous
execution of programs. 3. Super computer is the fastest computer. Super
computer is very expensive and used for complex mathematical calculation. It
has high storage capacity. 4. Characteristics of computer (i) High speed
(ii) Accuracy (iii) Storage capacity (iv) Diligence (v) Versatility
5. a. Workstation : Work station is a computer used for advanced application
which require a high processing power and high quality. b. Laptop : Laptop is a
miniature form of desktop. It is light weight computer. Because of their small size
it is considered to be mobile computers. c¢. Tablet : Tablet is like laptop; it is
powerful and have an inbuilt screen. Like hand held device. It allows to write
notes or draw pictures on screen.

Write T for True and F for False.

1. False 2. False 3. True 4. True 5. True

Chapter-3  Windows 7

Fun Activity
Pg-24
Do yourself.
Exercise
A. Choose the correct option.
l.a2.b3.c4.cS5.b
B. Fill in the blanks.
1. nine 2. personalization 3. Screensaver 4. Folder 5. Gadgets
C. Answer the following questions.
1. Features of window 7 are : (a) Personalize the Desktop : You can personalize
your desktop by changing wallpaper and screensaver, arranging icons and
gadgets etc. (b) Changing desktop wallpaper and screensaver : The
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background of the desktop is called the desktop background or desktop
wallpaper. Screen saver is a program which displays images on animation on the
screen. 2. To create a file in a folder follow these steps : Step 1 : Open the folder
by double clicking it. A window appears. Step 2 : Right click in the window. A
menu appears. Step 3 : Click on New. A submenu appears. Step 4 : Choose a text
document option. Step 5 : Type a name for the document. Step 6 : Double click
on the file to type text in it. 3. Gadgets are mini programs that provide
information at a glance and also provide access to frequently used tools. 4. File is
a collection of data and information. Folder is used to organized files and sub
folders. 5. Step 1 : Right click on the file or folder. A pop menu will appear.
Step 2 : Choose on the Rename option. Step 3 : The cursor will be placed below
the icon where the initial name was displayed. Step 4 : Edit the name as required
and press the enter key.

Read the clues to solve the crossword puzzle.

1. FOLDERS 2. RENAME 3. TASKBAR 4. GADGETS 5. SCREENSAVER

Chapter-4  MS-Word 2010

Fun Activity

Pg-34

1. MS Word 2010 2. Title Bar 3. Document Area 4. Status Bar 5. References Tab
Exercise

A.

B.

Choose the correct option.

1.b2.b3.c4.a5.¢

Fill in the blanks.

1. mailing 2. 8 3. Microsoft 4. Clipboard 5. row, columns

Match the following columns.

1.b2.c3.a4.e5.f6.d

Answer the following questions.

1. Microsoft Office Word is a word processor software from the Microsoft
company. It is a part of the Microsoft Office Suit. 2. Different tabs in MS Word :
(a) File tab (b) Home tab (c) Insert tab (d) Page layout tab (e) References tab
(f) Mailing tab (g) Review tab 3. To insert a table in your document follow the
steps : Step 1 : Click on the Insert tab. Step 2 : Click on the Table button. Step 3 :
Enter the number of rows and columns as required. 4. To create the bulleted list,
follow the steps : Step 1 : Position the cursor where you want to insert the bullets
list. Step 2 : Click on the bullet arrowhead from the name tab in the paragraph
group. Step 3 : The bullet will appear at the cursor position. Type the text and
press the Enter key. Step 4 : The next bulleted point will appear. 5. To create and
envelope follow the given steps : Step 1 : Set up your mailing list. Step 2 : Test
your envelope layout. Step 3 : Start the mail merge. Step 4 : Link your mailing
list to your main document. Step 5 : Add the address block to the envelope.
Label the parts of MS Word Window.

See picture in the book on Page No. 41
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Chapter-5  Formatting The Word Document

Fun Activity

Pg-45

Name the options of Home tab.

Left Align, Bold, Italic, Underline

Exercise

A. Choose the correct option.
1.b2.c3.c4.a

B. Fill in the blanks.
1. centre 2. Word Art 3. left, centre, right, justified 4. Left, Right 5. clip-art

C. Write T for True and F for False.
1. False 2. False 3. True 4. False 5. True

D. Answer the following questions.
1. Different types of alignment same : (a) Left Alignment (b) Centre Alignment
(¢) Right Alignment (d) Justified 2. Steps to change colour : Step 1 : Select the
text in your document whose colour you want to change. Step 2 : Click on the
Font Colour option down arrow in the font group on the Home tab. Step 3 : Move
mouse pointer over different colours and you will see the colour of the selected
text changing in your document accordingly. Step 4 : Click on the colour you
desire and that colour will be applied to your text. 3. In MS Word WordArt is the
pre-defined special effects. These styles can be readily used and can be chosen
from ‘Insert’ tab text group. 4. To insert a picture, follow the steps : Step 1 :Click
on the Insert tab. Step 2 : Click on the picture button. Step 3 : The insert picture
dialog box opens. Step 4 : Select the picture which you want to insert from the
required folder. Step 5 : Click on the Insert button.

Chapter-6  MS PowerPoint 2010

Fun Activity

Pg-52

Write the names of tabs of MS-Power Point.

1. Home 2. Animation 3. Insert 4. Slide show 5. Design 6. Review 7. View

Fun Activity

Pg-58

Match the columns correctly.

1.c2.a3.e4.b5.d

Exercise

A. Choose the correct option.
1.b2.c3.2a4.¢5.b6.b

B. Fill in the blanks.
1. slides 2. Status bar 3. F5 4. .pptx 5. Note pane

C. Answer the following questions.

1. MS PowerPoint is a software used to create presentation which contain text.
2. To create a New presentation follow the given steps : Step 1 : Click on the
Office button. Step 2 : Click on New option. Presentation dialog box will open.
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Step 3 : The slide layout gallery opens. Step 4 : Select a title and content slide.
3. Step 1: Click on Design tab. Step 2 : Click more button on right side of Themes
icon. Step 3 : Click desired theme at drop down galary. 4. Step 1 : Click on Insert
tab. Step 2 : In the illustration group, click on Clip art. Step 3 : In the Clipart task
pane, enter a search for box to find the related picture. Step 4 : Click on the Go
button. Step 5 : The pictures will be displayed. Click on the pictures which you
want to insert. 5. Step to save a presentation : Step 1 : Click on File button or Save
button in the Quick Access toolbox. Step 2 : Click on Save as or Save option.
Step 3 : Select the drive where you want to save the presentation. Step 4 : Type
the name of the presentation and then click on Save.

Label the MS PowerPoint window.

See picture in the book on Page No 66.

Chapter-7  More On LOGO

Fun Activity

Pg-64

Write the command for the given figure.

Rectangle : FD 60 RT 90, FD 40 RT 90, FD 60 RT 90
Square : REPEAT 4 [FD 60 RT 90]

Exercise

A. Choose the correct option.

B.

1.b2.a3.c4.c5.¢c

Write the full form of primitives.

1. Pen Up 2. Pen Down 3. Print 4. Pen Colour 5. BUT LAST 6. Clear Test
7. LEFT 8. Backward 9. Clear Screen 10. Forward

Fill in the blanks.

1. SET PC 2. REPEAT 3. FIRST 4. LAST 5. SET BG

Answer the following questions.

1. Repeat command reduces the number of commands to be written in order to
draw a figure. Example : To make a triangle Repeat 3 [FD 50 RT 120] 2. The
PEN UP or PU command lifts up the pen of the turtle. The Pen Down or PD
Command puts the pen down. 3. Some special commands are : (a) FIRST
(b) BUT FIRST OR BF (¢) LAST (d) BUT LAST OR BL 4. Fill command is used
to fill color in a closed figure. SET PC helps to draw coloured lines. SET BG
helps to give background color. 5. Drawing circles with REPEAT : A circle can
be drawn using REPEAT command. A full circle is drawn with 360°. To draw
star : Turtle turns 144° REPEAT 5(FD 120 RT 144)

Write LOGO commands to draw the following.

1. REPEAT with 180° 2. REPEAT 3 [FD 100 RT 120] 3. REPEAT 4 [FD 60 RT
90]14.REPEAT 6 [FD 100 RT 20] 5. FD 60 RT 90, FD 40 RT 90, FD 60 RT 90
What you will get on the screen, from the following commands.

Do Yourself.
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Chapter-8  Internet

Fun Activity

Pg-75

Do yourself.

Exercise

A. Choose the correct option.
1.b2.c3.a4.a

B. Fill in the blanks.
1. Electronic Mail 2. web browser 3. Inbox folder 4. Modem 5. Internet Service
Provider

C. Write T for True and F for False.
1. False 2. True 3. False 4. False 5. True

D. Answer the following questions.

1. A computer network is a group of computers connected together to share data
and resource. 2. Requirement for connecting to the internet : (a) Computer (b)
Modem (c¢) Telephone line (d) Internet browser (e) ISP 3. Internet Browser is a
software to help the computer access the information over internet. 4. To send an
E-mail follow the given steps : Step 1 : In the ‘To’ box write the receiver’s email
address. Step 2 : In the ‘Subject’ box, write the topics of the message. Step 3 : In
the ‘Message’ box, write the message. Step 4 : Click on the Send button. 5. An
e-mail has three components : User name, (@, domain name to send and receive
e-mail.

Chapter-9  Introduction To Tux Paint

Exercise

A. Label the Tux paint Window.
See picture in the book on Page No 89.

B. Fill in the blanks.
1. Tux 2. cost, Internet 3. canvas 4. Paint 5. Eraser

C. Match the following columns.
1.c2.e3.24.b5.f6.d

D. Write True for true and False for false.
1. True 2. False 3. False 4. True 5. False

E. Answer the following questions.
1. Tux paint is a single paint program designed for children for drawing and
colouring. 2. To start Tux Paint follow the give steps : Step 1 : Click on Start
button. Step 2 : Click on All program. Step 3 : Click on Tux paint. Step 4 : Now
click on Tux paint (full screen) 3. Undo Tool is used to cancel the last performed
action. Repeated use of this will cancel the previous undo effects one by one
starting from the last action. 4. To use Eraser tool to erase some part of drawing
follow the given steps : Step 1 : Click and select Eraser Tool. Step 2 : Select the
size of eraser as you required. Step 3 : Drag the eraser on the picture or text to
erase it. 5. (i) A drawing made with a variety of Magic Tools. (ii) A space scene
using Tux Paint Ruber stamps.
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Model Test Paper - 1

A.

B.

Fill in the blanks.

1. RAM 2. miniature 3. Folders 4. Microsoft 5. personalization 6. Rows, columns
Write the full form of the following.

1. Central Processing Unit 2. Arithmetic Logic Unit 3. Digital Versatile Disk
4. Visual Display Unit 5. Random Access Memory

Write the value of following.

1. 1024 Gigabytes 2. 1024 Megabytes 3. 1024 Kilobytes 4. 1024 Bytes 5. 8 bits
6. 4 bits

Name the different types of file given below.

Music, Photos, Zip files, Text files, Portable, Document File, MS Word File,
MS Excel File, Power Point File

Answer the following questions.

1. ROM : ROM stands for Read Only Memory. The memory from which you can
only read but cannot write on it. This type of memory is non-volatile RAM :
Random Access Memory is the internal memory of the CPU for storing data. It is
volatile memory. 2. Super computer is one of the fastest computers currently
available. Super computer is very expensive and used for complex mathematical
calculation. It has high storage capacity. 3. Different tabs in MS Word : (a) File
tab (b) Home tab (c) Insert tab (d) Page layout tab (e) References tab (f) Mailing
tab (g) Review tab 4. Desktop Gadgets are mini programs that provide
information at a glance and also provide access to frequently used tools. 5. To
create the bulleted list, follow the steps : Step 1 : Position the cursor where you
want to insert the bullets list. Step 2 : Click on the bullet arrow head from the
Name tab in the Paragraph group. Step 3 : The bullet bull appear at the cursor
position. Type the text and press the Enter key. Step 4 : The next bulleted point
will appear. 6. a. Work station is a computer used for advanced application
which require a high processing power and high quality. b. Cache memory is a
very high speed memory. It is used to hold those parts of data and program which
are most frequently used by CPU. It is faster than main memory. c. Microsoft
Office Word is a word processor software from the Microsoft Company. It is a
part of the Microsoft Office Suit.

Label the MS Word Window. Also, explain any four components.

Do yourself.

Model Test Paper - 2

B.

C.

D.

Write the full form of primitives.
1. Pen Up 2. Pen Down 3. Print 4. Pen Colour 5. BUT LAST 6. Clear Text
7. LEFT 8. Backward 9. Clear Screen 10. Forward

Fill in the blanks.

1. F5 2. Internet Service Provider 3. REPEAT 4. ERASER 5. .pptx
Write T for True and F for False.

1. True 2. True 3. False 4. False 5. True

Answer the following questions.
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1. To insert a picture, follow the steps : Step 1 : Click on the Insert tab.
Step 2 : Click on the picture button. Step 3 : The insert picture dialog box opens.
Step 4 : Select the picture which you want to insert from the required folder.
Step 5 : Click on the Insert button. 2. To create a new presentation follow the
given steps. Step 1 : Click on the Office button. Step 2 : Click on New option.
Presentation dialog box will open. Step 3 : The slide layout gallery opens.
Step 4 : Select a title and content slides. 3. To write and send an e-mail we should
follow the given steps : Step 1 : In the ‘To’ box write the receiver’s email
address. Step 2 : In the ‘Subject’ box, write the topics of the message. Step 3 : In
the ‘Message’ box, write the message. Step 4 : Click on the Send button.
4. (a) To fill the picture, the turtle should be inside the picture. (b) Turtle should
not touch any line of the picture. Before using the FIL primitives, the PENUP
primitives moves the turtle inside the picture. By using PEN DOWN one make
the turtle fill the picture. 5. Requirement for connecting to the internet :
(a) Computer (b) Modem (c) Telephone line (d) Internet browser (e) ISP 6. Tux
paint is a single paint program designed for children for drawing and colouring.
Draw the following shapes on the computer in LOGO program.

Do yourself.

Label the components of MS PowerPoint 2010.

Do yourself.

National Cyber Olympiad

Logical Reasoning

l.c2.b3.c

Computers And Information Technology
4.dS5.b6.c7.b8.a9.a10.al1l.c12.d13.a
Achievers Section

14.d15. ¢
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Computer - 5

Chapter-1  Computer Languages

A.

B.

Choose the correct option.

1.b2.a3.c4.b

Fill in the blanks.

1. high level 2. artificial intelligence 3. Binary language 4. Booting

Match the following columns.

l.e2.c3.b4.a5.d

Answer the following questions.

1. Computer also need expression to communicate with users. It understand the
Binary language which is 0 and 1. We give the instruction to computer to perform
a specific job users design many programming language through which we can
communicate with the computer. 2. Based on their history of development,
computer languages fall the three broad categories. They are : (a) Machine level
languages (b) Assembly level languages (c¢) High level languages 3. (4 GL’s) are
casier to use than 3GL’s and 4 GL’s include ORACLE. SQL etc. These languages
consist of statement similar to statement in a human language. 5 GL’s language
are actually some thing of a mystery whether they exist or not. In principal, they
would use artificial intelligence. 4. a. Booting : When we switch ON a computer,
the necessary files of the operating system get loaded into the memory of the
computer to make it ready to accept commands. This process of loading files is
called Booting. b. Program : Program is a set of instructions which is converted
to machine language using a compiler or an interpreter. ¢. Virus : Virus is a
program or code that is loaded into your computer without your knowledge and
runs against your wishes. A simple virus that can make a copy itself over and over
again. 5. Compiler : A compiler reads the whole source code and translate it into
a computer machine code program to perform the required tasks which is outputs
as a new file. Interpreter : An interpreter reads the source code one instruction
on line at a time, converts this line into machine code and executes it.

Chapter-2  Windows 7

Fun Activity

Pg-12

Name the programs option on start menu.

1. Adobe bridge 2. APS designer 4.0 3. Calculator 4. Notepad 5. Paint 6. MS Word
7. MS PowerPoint 8. MS Excel 9. Window Media Player 10. Corel Ventura 10

Exercise
A. Choose the correct option.
l.a2.a3.c4.b
B. Fill in the blanks.
1. copy 2. Window explorer 3. information 4. contents pane 5. Folder
C. Write T for True and F for False.

1. False 2. False 3. True 4. True 5. False

Digital World 1 to 5 29



Answer the following questions.

1. Windows explorer is a program that helps in navigating from one place to
another to view and manage files and folders present in various drives or folders.
2. By copying a file or folder we can copy or make duplicate, one or more files or
folders in different locations. 3. To create a new folder, follow the steps : Step 1 :
Go to the location where you want to create a new folder. Step 2 : Right click on
the blank area of the window. Step 3 : Click to New option and click on Folder.
4. Window desktop is the first screen when you opened the computer. Desktop
consists of pictures called icons, files, documents and wallpaper. Desktop serves
as a surface for your work. 5. Folders help in arranging files into organized
groups which make it easy to locate any particular file. Files help to locate a
particular file in the computer memory.

Chapter-3  MS Word 2010
Exercise

A.

B.

30

Choose the correct option.

1.b2.a3.b4.c5.a

Fill in the blanks.

1. Crop 2. Margen 3. Insert 4. Print orientation 5. Document

Answer the following questions.

1. Mail merge is the facility in MS Word used to send the same letter to a number
of people. To locate a mail merge document you should follow the following
steps : Step 1 : Open an existing document or create a new one. Step 2 : From the
Mailing tab, click the start Mail Merge command and select step by step mail
Merge Wizard from the drop down menu. Step 3 : The mail merge task pane
appears on the right side of the screen and will guide you through the six main
steps to complete to merge. Step 4 : Choose the type of document. Step 5 : Select
the current document. Step 6 : Now you will need an address list. Step 7 : The
Mail Merge Recipients dialog box opens click on OK button. 2. Page
orientation is the layout position of paper printing. There are two types of
orientations. 3. To crop a picture you should follow the given steps. Step 1 : Click
on the Clip Art or Picture. Step 2 : Select Crop button from Format tab.
Step 3 : Drag the crop handles to crop the pictures. 4. Step 1 : To create a number
list follow the given steps. Click on Home tab. Step 2 : Go to Paragraph Group.
Step 3 : Choose either bullet or number list, select the style you like in the drop
down menu. Step 4 : Continue to type and press Enter key after each line. Next
bullet or number will generate automatically. Step 5 : To close the tool. Press the
Bullets or Numbering option again. 5. A table of contents is just like the list of
chapters at the beginning of a book. Step 1 : Highlight he first heading and select
heading. To create a table contents follow the given steps. 1. Step 2 : Once you
have set all your heading, click on the Reference Tab at the top of the screen.
Step 3 : Place your cursor at the beginning of the document. This is the place
where the table of contents will be inserted. Step 4 : Notice that a table of content
has been inserted at the head of your document.
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Chapter-4  MS PowerPoint 2010

Fun Activity

Pg-32

Write the steps to open MS PowerPoint.
Step 1 : Click on the Start button.

Step 2 : Click on the All programs.

Step 3 : Selct the MS PowerPoint option.
Step 4 : Click on MS PowerPoint.

Pg-36

Fun Activity

Write the steps to open any slide.

Click on the All program from the Start menu.
Click on the MS PowerPoint.

Select the File menu in MS PowerPoint.

Click on Save as you. See a list of all presentation and choose you file and open any
slide.

Write the steps to save any slide.

Click the File tab.

Click on Save button.

Type the name of the file in the file name box.

Click on Save button.

Exercise

A. Choose the correct option.
1.c2.a3.c4.a5.c

B. Fill in the blanks.
1. three 2. Insert 3. escape, duration 4. Normal view 5. Slide Sorter View

C. Write T for True and F for False.
1. True 2. False 3. True 4. False 5. True

D. Answer the following questions.
1. Presentation is a collection of individual slides that contain information on a
topic. 2. Themes are applying to see a slide the set of predesigned format of text,
colour schemes and graphics effects. 3. In different views such as (a) Normal
view (b) Slide Sorter view (c) Note Page view (d) Reading (e) Slide Show view
4. Animation refers to the movement and sound accompanying text or image in
your presentation. 5. Slides of a presentation can be advance in two ways on
mouse click or automatically after a specified time.

E. Identify and write the names of the following options.
1. Zoom 2. Normal 3. Adding sound to transition apply to all 4. Set up slide show

Chapter-5  Introduction To MS Excel 2010

Exercise

A. Choose the correct option.
l.a2.a3.b4.c5.¢c
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Fill in the blanks.

1. active cell 2. 21, A 3. Pie 4. Scatter 5. Many

Answer the following questions.

1. MS Excel is a part of MS Office Suits. MS Excel consists of row and columns.
The row and columns intersect to form a cell. 2. Different types of chart are :
(a) Column chart (b) Bar chart (¢) Line chart (d) Area chart (e) Pie chart
(f) Doughnut chart (g) Radar chart (h) XY chart 3. To cut and copy data in MS.
Excel follow the given steps. Step 1 : Select the range of cells which you want to
copy. Step 2 : Click on the Home tab. Step 3 : Click on the Copy option. Step 4 :
Click in the cell where you want the first entry of the selected data to be placed.
Step 5 : Click on the Paste button. 4. Each cell in a worksheet has a unique
address formed by the combination of the number and the column letter of the
intersecting row and column. For example, a cell formed at the intersection of
column A and raw 1 will have the address Al. 5. A worksheet is divided into a
grid of raws and columns. Whereas a workbook in MS Excel is made up of
worksheets.

Name the given chart type.

1. Pie chart 2. Doughnut chart 3. Radar chart 4. XY chart 5. Coloumn chart
6. Area chart

Chapter-6  Algorithms And Flowcharts

Fun Activity

Pg-57

Do yourself.

Exercise

A. Choose the correct option.
1.a2.a23.a4.b5.b

B. Fill in the blanks.
1. START 2. STOP 3. Connector 4. Flowchart 5. Algorithm

C. Name the given symbol and their uses.
Input/output Box, Processing Box, START/STOP Box, DECISION Box

D. Answer the following questions.
1. Algorithm is a set of instruction in a defined sequence. 2. A flowchart is a type
of diagram that represents an algorithm, workflow or process, showing the steps
as boxes of various kinds, and their order by connecting them with arrows. 3. The
instruction which we provide to computer should be in a define order. This is
called procedure writing. 4. Connector is used to connect the process/flow. It is
labelled with capital letters to show matching. 5. Arrow indicates the flow of
information in a flowchart. It also shows the flow logic of a program.

E. Write an algrorithm and draw a flowchart for the following.
1. Take kite, Tie with string, Pull in air. Make it fly and enjoy. 2. Take two
numbers, divide first by second. Get the quotient and remainder stop.
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Chapter-7  Procedures Of MS LOGO

Exercise

A. Choose the correct option.
l.a2.b3.c4.c5.a

B. Fill in the blanks.
1. To 2. Edall 3. editor 4. Erase 5. Load

C. Write T for True and F for False.
1. False 2. True 3. True 4. False 5. False

D. Answer the following questions.
1. A procedure is a step by step sequence of doing an activity. LOGO procedure
is a set of commands to perform a particular task. 2. A procedure has three parts :
Tittle, Body and End. 3. (i) A procedure can have letters, numbers and symbols.
(ii) The first character should always be a letter. (if) We should not use LOGO
command name. 4. In LOGO you can fill the pictures with color. To fill the
picture which is to be filled, after defining the circle, click on set option in menu
bar and select color. The color dialog box will appear. Select any color of your
choice and click on OK. 5. There are five arithmetic function : (i) Sum
(ii) Difference (iii) Product (iv) Quotient (v) Remainder. There are three types of
logical operators —greater than (>), less than (<) and equal to (=).

E. Write the steps involved in the following.

1. REPEAT 6 [FD 100 RT 60] 2. To Save the procedure in MSW LOGO, click
on the Input box to make it active and type Save Procedure Name. 3. To erase the
procedure square in MSW LOGO type : ERASE “SQUARE”

Chapter-8§  More On Internet

Fun Activity
Pg-79
Do yourself.
Fun Activity
Pg-80
Do yourself.
Exercise
A. Choose the correct option.
1.c2.b3.c4.a5.c
B. Fill in the blanks.
1. Uniform Resource Locator 2. ARPANET 3. dial up 4. Home 5. personal
C. Write T for True and F for False.
1. False 2. True 3. False 4. True 5. False
D. Answer the following questions.

1. WWW is a service available on the internet. It consists of millions of web
documents or web pages connected to each other through hyperlinks to form
world’s biggest reservoir of information. 2. Search engines is a special type of
website that is designed to help us in finding the required information on WWW.
Step 1 : Open the search engine google.com.in Step 2 : Enter your search term in
the search term box. Step 3 : Click on the google search button. Step 4 : Many
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links of the search results will be shown. Click on anyone to open and view the
contents. Step 5 : Click on the back to go back to the search results and explore
the other search results. 3. Downloading transferring information from the
internet onto your computer uploading transferring from your computer to the
internet. 4. (a) Internet is used for finding information. (b) Internet is used for
education. (c) Internet is used for sending E-Greeting cards. 5. Netiquette are the
manners to be followed while using internet. (i) Spell-check what you have
written to help others understand your correctly. (ii) Do not use all caps in your
mails or online message because it is considered shouting. (iii) Do yourself even
when you are online and do not say or do things that you will not do otherwise.
6. (i) Do not respond to any message that in anyway make you fell
uncomfortable. (ii) Always communicate with your parents so that together you
can set up rules for going online.

Chapter-9  E-Mail

Exercise
A. Choose the correct option.
1.c2.a3.c4.c5.¢c
B. Fill in the blanks.
1. Electronic mail 2. Reply 3. internet 4. attachment 5. @
C. Write T for True and F for False.
1. False 2. True 3. False 4. False 5. False
D. Answer the following questions.

1. Email service is one of the fastest modes of communication. To open an e-mail
account follow the given steps. 2. Step 1 : Start a web browser such as Google
Chrome or Mozilla Firefox. Step 2 : Type the address of any e-mail service
provider in the Address bar of the browser. Step 3 : On the top right corner of the
page, you will see new to Gmail? Click on create an account button. Step 4 : You
will see some fields. Fill up all the necessary details in the given text boxes.
Step 5 : Click on the create my account button to complete the process of
registration. 3. An e-mail address is used to receive and send messages. Example :
WWW.Yahoo.Com 4. Using e-mail, we can communicate directly with our
friends and family members. We can send personal or official letters, register
complaints and exchange pictures or other files. 5. Inbox : The message sent to
you comes in your inbox. Qutbox : The message that are ready to be sent, collect
in this folder. Sent Item : A copy of sent message is stored here.

Chapter-10 Windows 8 Overview

Exercise
A. Fill in the blanks.
1. October 2012 2. Start 3. screen 4. Window defender 5. tiles
B. Write T for true and F for false.
1.F2.T3.F4.F5. T
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Answer the following questions.

1. Window 8 is the latest version of Microsoft Windows which is released in
October 2012. It has no Start button instead have tiles for various applications.
2. The major difference between other versions of windows and window 8 is that
there is no Start button. 3. Three features of window 8 : (i) Start screen (ii) Hot
corners (iii) Charms bar 4. Three advantages of using window 8 (a) New lock
screen (b) Improved search function (¢) Improved security 5. Step 1 : Click on
sittings from the Charms bar. Step 2 : Click on Power button from the Setting bar.
Step 3 : Three options are available; Sleep, Shut down and Restart. Choose as per
required.

Name the tools present on the charms bar.

Do yourself.

Model Test Paper - 1

A.

B.

Choose the correct option.

l.c2.a3.b4.a5.c

Fill in the blanks.

1. copy 2. Binary digit 3. three 4. Print oriental 5. many

Answer the following questions.

1. Hundred of programming languages are currently used around the world.
Based on their history of development, computer languages fall the three broad
categories. They are : (a) Machine level languages (b) Assembly level languages
(¢) High level languages 2. Folders helps in arranging files into organized groups
which makes it easy to locate any particular file. Files help to locate a particular
file in the computer memory. There are many types of files. 3. Animation refers
to the movement and sound accompanying text or image in your presentation.
4. Step 1 : Select the range of data to be represented along the chart. Step 2 : On
the Insert tab, in the Charts group, choose column and select clustered column.
Step 3 : Click to select a chart type and finally click on next button, on the dialog
box. 5. A table of contents is just like the test of chapters at the beginning of a
book. Step 1 : Highlight the first heading and select heading 1. Step 2 : Once you
have set all your heading, click on the Reference tab at the top of the screen.
Step 3 : Place your cursor at the beginning of the document. This is the place
where the table of contents will be inserted. Step 4 : Notice that a table of content
has been inserted at the head of your document.

Label the window explorer screen.

Do yourself.

Name the following charts.

Column chart, Pie chart, Line chart, Bar chart, XY chart

Match the following columns.

1.e2.c3.b4.a5.d

Model Test Paper - 2

A.

Fill in the blanks.
1. Edall 2. Algorithm 3. October 2012 4. Internet 5. ARPANET
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B. Complete the following table.
Do yourself.

C. Write T for True and F for False.
1. False 2. False 3. True 4. False 5. False

D. Answer the following questions.
1. Algorithm is a set of instructions in a defined sequence. 2. Downloading
transferring information from the internet onto your computer uploading
transferring from your computer to the internet. 3. A blank e-mail compose
window well appear, after clicking on Compose button. You will see various
field in this window where you can type information some fields are as follow :
To Field : This is where you write the e-mail address of person receiving the
e-mail. CC Field : The CC stand for carbon copy. Subject Field : Here you type
a simple topic heading or summary of the message. 4. (i) A procedure can have
letters, numbers and symbols. (ii) The first character should always be a letter.
(i) We should not use LOGO command name. 5. Three features of window 8 :
(i) Start screen (ii) Hot corners (iii) Charms bar 6. Inbox : The message sent to
you comes in your inbox. Outbox : The message that are ready to be sent, collect
in this folder. Sent Item : A copy of sent message is stored here.

E. Write the steps involved in the following.
1. REPEAT 6 [FD 100, RT 60] 2. (i) Click on File Menu. (ii) Click on Save
option. (iii) Define name in File name box. (iv) Click on Save button. 3. The erase
the entire procedure. Type Erase and name of the procedure and press Enter key.
This command tells LOGO to forget about procedure you have typed. type Erase
“Square.”

F. Write an algorithm and draw a flowchart for the following.
Do yourself.

National Cyber Olympiad

Logical Reasoning

1.d2.c3.c4.b

Computers And Information Technology
5.¢6.¢7.d8.d9.b10.d11.d 12.a13.d
Achievers Section

14.d 15.a
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NOTES




NOTES







Some salient features the series are :

This series explains the theoretical aspect in simple
language and conceptually to make student familiar
with the latest technologies.

In this, chapter emphasis on the goals of the chapter.
Practical learning is facilitated through interesting
activities, within and at the end of the chapter.

Step-by-step working of tools and programs enhance
the knowledge, in lab encourages students to explore
the concepts.

Summary of important points are provided with lot of
exercises at the end of the chapters.

It is based on extensive research of various topics as
regards the scholastic and co-scholastic requirements.
At the end of the books, Test papers and National
Cyber Olympiad quiz is given, aims at helping children
to participate in the National Cyber Olympiad

conducted by the Science Olympiad Foundation (SOF).
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